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Introduction

This chapter contains:

Important License Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Platform Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

VM Environments Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Adobe Acrobat and Acrobat Reader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Purpose and Use of this Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Upgrade Recommendation or Trial Mode Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Specialty Inks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

The FreeFlow Variable Information Suite 18.1.1 release is an update to FreeFlow Variable Information Suite 18.1.0, 
18.0.6, 18.0.4, 18.0.3, 18.0.2, 18.0.1, and 18.0.0. The term Variable Information Suite refers to one or more of the 
available FreeFlow Variable Information Suite products.

This release contains security compliance updates, VI Design Express support for Universal binary (Apple Silicon and 
Intel based Mac), and upgrades to the installer affecting all FreeFlow Variable Information Suite applications. 
Therefore, we recommend an upgrade of all suite products.

Before you begin:

• Stop all FreeFlow VI Suite programs that are running currently.

• Close and exit all FreeFlow VI Suite programs that are running currently.

For example, if you are installing Xerox® FreeFlow® VI eCompose, before you begin installing a newer version of the 
product, exit VI eCompose. If VI eCompose services are running, before you begin any installation, close and exit 
the program.



Important License Information

If you are upgrading from a prior major release, for example, versions 15.0, 15.0.1.0, 15.0.2.0, 15.0.3.0, 16.0.0.0, 
16.0.1.0, 16.0.2.0, 16.0.3.0, 17.0.0.0, or 17.0.x to enable the product, obtain a version 18.0.0 license file.

• For customers: Use the original SWAP key supplied with your original order or purchase. At the License Menu, 
enter the SWAP key.

• For internal updates: Refer to the information supplied in the ISA or MAPS systems.

Note: When you are updating Xerox® VIPP® Manage Utility on a Xerox® FreeFlow Print Server (FFPS) device, 
no license update is required if the previous version of the software license was activated.
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Platform Support

SYSTEM REQUIREMENTS

• For processor, memory, and disk space requirements, refer to the system requirements for installing the 
Windows Operating System.

• A screen resolution of 1024 x 768. The higher resolution is preferred.

• All FreeFlow VI Suite products run on the following 64-bit operating systems:

WINDOWS 64 BIT  

Windows 10, versions 21H2 and 22H2 Ensure that Windows 10 is maintained at the latest supported 
software level. 

Windows 11, versions 22H2, 23H2, and 
24H2 

Ensure that Windows 11 is maintained at the latest supported 
software level. 

Windows Server 2016 Ensure that Windows Server 2016 is maintained at the latest 
supported software level. 

Windows Server 2019 Ensure that Windows Server 2019 is maintained at the latest 
supported software level. 

Windows Server 2022 Ensure that Windows 2022 is maintained at the latest supported 
software level. 

Windows Server 2025 Ensure that Windows 2025 is maintained at the latest supported 
software level. 

MACOS FOR VI DESIGN EXPRESS ONLY VERSION 

Sequoia 15 

Sonoma 14.1 or earlier 

Ventura 13.2 or later 

Monterey 12.1 or later 

Note: The following software is not supported: Foundation, Core, Core Server without Desktop Experience, 
Home, Mobile, the Internet of Things, Starter, S, Team, and Essential editions of all Microsoft Operating 
Systems.

Note: From 17.0.0.0 release onward, VI Suite applications are not supporting 32-bit Operating Systems. If 
you run the VI Suite 18.0.2 or later installation setup in 32-bit Operating System, a message Windows 
error 216 appears.

The following table provides information about VI Design Express support for Adobe InDesign versions: 
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FREEFLOW VI DESIGN 
EXPRESS VERSIONS SUPPORTED ADOBE INDESIGN VERSIONS SUPPORTED 

16* 2021 (v16*) 2020 (v15.*) No longer supported 

17* 2022 (v17*) 2021  No longer supported 

18.0.0 2022 (v17*) 2021  No longer supported 

18.0.1 2022 (v17*) 2021  No longer supported 

18.0.2 2023 (v18.2 or later)  2022 (v17.4 or later)  No longer supported 

18.0.3 2023 (v18.2 or later)  2022 (v17.4 or later)  No longer supported 

18.0.4 2024 (v19.0 or later) 2023 (v18.2 or later)  No longer supported 

18.0.6 2024 (v19.0.1 or later) 2023 (v18.2 or later) Supported* 

18.1.0 2024 (v19.0.1 or later) 2023 (v18.2 or later) Supported* 

18.1.1 2025 (v20.0 or later) 2024 (v19.0.1 or later) Available on www.xerox. 
com. 

*Not available on www.xerox.com. 

Note: Only the current and a previous version of Adobe's Creative Cloud InDesign is supported for each 
release.

Note: Only the current version and one earlier (major) version of any VI Suite software is supported.

Note: You can run an earlier version of VI Suite software, but support will only be available for the current 
and minus one versions of the software.

Note: FreeFlow VI Design Express 18.1.1 is supported on Apple Mac systems using Apple silicon (M1/M2/M3, 
M4) in native mode and Intel based Mac systems.

Note: InDesign 2024 is supported in Rosetta mode in macOS Monterey, Ventura, Sonoma, and Sequoia. 
InDesign 2025 is supported in Rosetta mode in macOS Sequoia.

For FreeFlow VI Design Express for Mac and Windows operating system support, refer to the Adobe InDesign 
System Requirements found at the Adobe website.

We recommend Microsoft Windows Copilot should be disabled. The following steps states how to disable Copilot in 
Windows 11.

1. Open the Windows 11 Start menu and type Copilot.

2. Select Copilot to open the settings screen.

3. Locate Copilot and select Off.

Note: Instructions are based on Copilot (preview) as of January 2024 and subject to change in future 
Windows 11 updates.
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VM Environments Support

All products, except the VI Compose product, can operate in a VM environment. No support is offered for the 
configuration or management of the VM system. Where applicable, for license activation, each VM system requires 
a unique NIC or Mac address.
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Adobe Acrobat and Acrobat Reader

For important information about versions of Adobe Acrobat and Adobe Acrobat Reader, access the FreeFlow VI 
eCompose information, then refer to the Adobe Acrobat section.

It is important to review the Adobe Acrobat section for information about APPE, PDF, and VT requirements, and the 
required settings for Adobe Acrobat and Adobe Acrobat Reader.
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Purpose and Use of this Document

If you are upgrading from a prior release of the FreeFlow VI Suite software, to become familiar with new or 
enhanced content, read this document.

Refer to the FreeFlow VI Suite release documentation on the www.xerox.com website.

1. In a Web browser, type www.xerox.com.

2. Select Customer Support > All Support and Drivers.

3. For product type, select Software & Platforms, then select FreeFlow > FreeFlow Variable Information Suite.

4. On the FreeFlow Variable Information Suite page, select Documentation. 

Note: You can find the FreeFlow VI Design Express documentation in the Installer download zip file that 
has the .dmg extension. For the latest information, it is recommended that you read the Readme.txt file 
that is installed with each product. 
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Upgrade Recommendation or Trial Mode Information

It is recommended that whenever you upgrade one component of the FreeFlow VI Suite, you upgrade all other VI 
Suite components. Keeping all components up to date helps to avoid VI Suite product mismatches that can result in 
VIPP® jobs failing with errors, such as Command Not Found.

When using FreeFlow VI Design Express and FreeFlow VI Design Pro, it is critical that you upgrade any VI 
component that renders the VIPP® application. The components include VI Compose on the printer, and VI 
eCompose, which generates PDF files from VIPP® applications.

To locate the latest versions of the FreeFlow VI Suite components on the www.xerox.com website:

1. In a Web browser, type www.xerox.com.

2. Select Customer Support > All Support and Drivers.

3. For product type, select Software & Platforms, then select FreeFlow > FreeFlow Variable Information Suite.

4. On the FreeFlow Variable Information Suite page, select the Software and Solutions tab.

Note: The version of Xerox® VIPP® Manage Utility software and the version of FFPS server are not 
dependent upon each other. An FFPS server is pre-installed with a demonstration version of Xerox® VIPP® 

Manage software limited to 200 pages per job. It is recommended that you upgrade the version of Xerox® 

VIPP® Manage software on the FFPS server with the latest available Xerox® VIPP® Manage release. The FFPS 
Update Manager is one way to update the version of Xerox® VIPP® Manage software on FFPS servers. 

When the VI Suite of applications is running in trial mode, the number of pages per job is limited to 200 
pages. When printing VI jobs on office printers under trial mode, the limit is 10 pages. For production 
printers, the trial mode limit is 200 pages.

When you run the VI Suite of applications in trial mode, this table describes the trial period for each application.

APPLICATION TRIAL PERIOD AFTER INITIAL INSTALLATION 

Xerox® FreeFlow® VI Design Pro 60 days 

Xerox® FreeFlow® VI Explorer 0 days

No Trial

Xerox® FreeFlow® VI Design Express 30 days 

Xerox® FreeFlow® VI eCompose 60 days 

Xerox® FreeFlow® VI Compose (installed on the DFE)  See note above in regard to trial mode and pages or 
job 
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Specialty Inks

Specialty Inks (SI) are an option on Xerox DC1000/800 and iGen5 devices, supported by FFPS, and EFI digital front 
end devices. Specialty Inks include: 

• Clear

• Gold

• Silver

Note: Prior to the version 14.0 software release, the Specialty Inks feature was known as Clear Dry Ink, and 
the only color option was Clear. With the addition of the Gold and Silver options, the feature is renamed 
Specialty Inks. The specialty inks are not required for FreeFlow VI Specialty or Security imaging.
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New Features in Xerox® FreeFlow® VI Design Express 18.1.1

This section lists all new features introduced since the release of Xerox® FreeFlow® VI Design Express 18.1.0.

New features and enhancements include the following:

• FreeFlow VI Design Express is supported as universal binary for macOS (Apple Mac systems using Apple silicon 
(M1/M2/M3/M4) in native mode and Intel based Mac systems).

• InDesign 2024 is supported in Rosetta mode in macOS Monterey, Ventura, Sonoma, and Sequoia.

• InDesign 2025 is supported in Rosetta mode in macOS Sequoia.
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New Features in Xerox® FreeFlow® VI Design Express 18.1.0

This section lists all new features introduced since the release of Xerox® FreeFlow® VI Design Express 18.0.6.

New features and enhancements include the following: 

• Ability to add verified Variable Pantographs using VI Design Express.  

– VI Design Express Software allow users to select and insert VI Suite Specialty/Security Imaging (SI) Variable 
Pantographs (VPGs) into the user’s existing, or new, Adobe Creative Cloud InDesign (.indd) document. 
VIPP® allows users to use VI Design Express (VDE) along with Variable Pantograph (VPG) v2 swatches to 
ensure good, validated, pantographs are used. 

Note: Only verified VPGs as stated in the SI Customer report on www.xerox.com are allowed to be 
inserted at this time.

• An underlying architecture change was made.

• Adobe supporting libraries were updated.
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New Features in Xerox® FreeFlow® VI Design Express 18.0.4

This section lists all new features introduced since the release of Xerox® FreeFlow® VI Design Express 18.0.2.

New features and enhancements include the following:

Support for Adobe InDesign 2024 (version 19.0 or later) has been added.

Support for Adobe InDesign 2023 (version 18.2 or later).

Support for Adobe InDesign 2022 has been removed.
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New Features in Xerox® FreeFlow® VI Design Express 18.0.2

This section lists all new features introduced since the release of Xerox® FreeFlow® VI Design Express 18.0.0.

New features and enhancements include the following:

Support for Adobe InDesign 2023 (version 18.2 or later) has been added.

Support for Adobe InDesign 2022 (version 17.4 or later).

Support for Adobe InDesign 2021 has been removed.
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New Features in Xerox® FreeFlow® VI Design Express 18.0.0

This section lists all new features introduced since the release of Xerox® FreeFlow® VI Design Express 17.0.1.

New features and enhancements include the following:

VVeerrssiioonn 1188..00..00

Capability to submit VIPP® jobs to Xerox® FreeFlow® VI eCompose software and displays job status at Xerox® 

FreeFlow® VI eCompose. New dialogs have been introduced to support the ability to submit a VIPP® job from 
Xerox® FreeFlow® VI Design Express to Xerox® FreeFlow® VI eCompose and displays job status at Xerox® FreeFlow® 

VI eCompose. 

Note: VIPP® job submission to Xerox® FreeFlow® VI eCompose Hot folder option has been removed in 
18.0.0.

Enhancements have been made to the Pantograph Specialty Imaging effect to be more efficient and effective. For 
more information, contact your Xerox representative.

VIPP® 18 0.0 automatically installs and enables options to submit jobs to Xerox® FreeFlow® Core and Xerox® 

FreeFlow® VI eCompose, but the ability to transmit jobs will result in an error until the configuration has been 
completed. For more information on setup, refer to the Xerox® FreeFlow® VI Design Express Software User Guide.

FreeFlow VI Design Express supports Adobe InDesign 2022 (version 17.*).
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Xerox® FreeFlow® VI Design Pro

This chapter contains:

Xerox® FreeFlow® VI Design Pro 18.0.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22



Xerox® FreeFlow® VI Design Pro 18.0.0

The Xerox® FreeFlow® VI Design Pro application user interface has been updated in areas of new tool icons. For 
more information, refer to the Xerox® FreeFlow® VI Design Pro User Guide.
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Xerox® FreeFlow® VI eCompose

This chapter contains:

Platform Support for Xerox® FreeFlow® VI eCompose 18.0.x . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24



Platform Support for Xerox® FreeFlow® VI eCompose 18.0.x

Xerox® FreeFlow® VI eCompose software runs on the following 64-bit operating systems:

WINDOWS 64 BIT  

Windows 10, versions 21H2 and 22H2 Ensure that Windows 10 is maintained at the latest supported 
software level. 

Windows 11 Ensure that Windows 11 is maintained at the latest supported 
software level. 

Windows Server 2016 Ensure that Windows Server 2016 is maintained at the latest 
supported software level. 

Windows Server 2019 Ensure that Windows Server 2019 is maintained at the latest 
supported software level. 

Windows Server 2022 Ensure that Windows 2022 is maintained at the latest supported 
software level. 

Note: If you intend to enable the optional Xerox® FreeFlow® VI eCompose Web Application, before you run 
the Xerox® FreeFlow® VI eCompose installer, install Microsoft .NET Framework 4.8 from the Microsoft 
website. Previously, Xerox® FreeFlow® VI eCompose Web Application was known as Xerox® FreeFlow® VI 
eCompose Web Server.

Web browsers supported are the current versions of modern browsers from Apple®, Google®, Microsoft®, and 
Mozilla®.

Microsoft Internet Explorer and the original Microsoft Edge are not supported. Only Microsoft Chromium Edge is 
supported.

Browsers older than one year are not supported. To avoid compatibility issues, always use the latest version of the 
browser.

Always use desktop computer browsers. Mobile device browsers can exhibit display issues.
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Xerox® FreeFlow® VI Explorer Software

This chapter contains:

Xerox® FreeFlow® VI Explorer 18.0.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26



Xerox® FreeFlow® VI Explorer 18.0.0

The Xerox® FreeFlow® VI Explorer application user interface has been updated in areas of new tool icons. For more 
information, refer to the Xerox® FreeFlow® VI Explorer Software User Guide.
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Xerox® VIPP® Manage Utility

This chapter contains:

Xerox® VIPP® Manage Utility 18.0.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28



Xerox® VIPP® Manage Utility 18.0.6

To address a potential security concern around the storage and management of printer groups, as allowed within 
the Xerox® VIPP® Manage Utility, a new methodology has been put in place and will be enacted upon an upgrade 
to your Xerox® VIPP® Manage Utility.
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Resolved Issues

This chapter contains:

Resolved Issues from Previous Versions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30



Resolved Issues from Previous Versions

VVeerrssiioonn 1188..00..66

XXeerrooxx®® FFrreeeeFFllooww®® VVII eeCCoommppoossee 

• Fixed naming issues with some FreeFlow VI eCompose output files, where some ”.” and “-“ characters are being 
replaced by the “_” character.

• Fixed the issue that when running the InstallServices.js script, FreeFlow VI eCompose Service, FreeFlow VI 
eCompose Dispatch Service, and FreeFlow VI eCompose Watched Folders Service are failed to properly register, 
install, and start as Windows Services.

• Fixed the issue when uninstalling Xerox® FreeFlow® VI eCompose of all services that have not been properly 
stopped, a dialog will appear as Local server or other related services are running. A new 
dialog will appear asking to select option Yes to automatically close the services and continue the uninstall or 
select option No to exit the uninstaller.

XXeerrooxx®® FFrreeeeFFllooww®® VVII DDeessiiggnn EExxpprreessss

• Fixed the issue that when creating an Advanced Function, if the checkbox for Save Advanced Function is not 
checked, unknown results may occur while exporting or importing an Advanced Function later.

• Adobe Acrobat version 24.002.20736 or later resolves an issue that when PDFs are generated from FreeFlow VI 
Design Express, Acrobat considers the PDF is a scanned PDF instead of displaying comparable text.

VVeerrssiioonn 1188..00..11

XXeerrooxx®® FFrreeeeFFllooww®® VVII DDeessiiggnn PPrroo 

• Fixed the issue when upgrading to 18.0.0, the uninstallation of the previous version resulted in the removal of 
the xgfc directory and other installed VI Suite applications.

XXeerrooxx®® FFrreeeeFFllooww®® VVII EExxpplloorreerr 

• Fixed the issue when upgrading to 18.0.0, the uninstallation of the previous version resulted in the removal of 
the xgfc directory and other installed VI Suite applications.

VVeerrssiioonn 1188..00..00

XXeerrooxx®® FFrreeeeFFllooww®® VVII DDeessiiggnn EExxpprreessss

• Fixed the issue where incorrect QR code generated with VI Design Express 17.0.1.

• Fixed the issue where Barcode displays in INDD in strange location, but prints in correct location.

• Fixed VI Design Express crash issue when selecting Advanced Function.

XXeerrooxx®® FFrreeeeFFllooww®® VVII eeCCoommppoossee

• Fixed Web Job Submission Service (WJSS) where under some circumstances, returning an XML response with 
two root nodes.

• Fixed Large, concatenated PDF files fail processing in eCompose.

• Fixed the issue where VI eCompose uses an A4 job options default instead of a US Letter default when US 
Letter media is selected at installation.
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XXeerrooxx®® FFrreeeeFFllooww®® VVII CCoommppoossee 

• Fixed the issue on Fiery DFE for license module while upgrading the installer.

• Fixed the issue where VIPP® XML Job not printing correctly on FFPS with Slipsheet tag.

• A VIPP job referencing a PDF on a remote file system will fail.

XXeerrooxx®® FFrreeeeFFllooww®® VVII EExxpplloorreerr 

• Fixed the issue with printing of VIPP® PDF with embedded EPS resulting in font substitution issue. Font inclusion 
options are added to the pdftops utility. The options are specified in the file pdftonps.ini. The capability is also 
available on Xerox® FreeFlow® VI Design Pro and Xerox® FreeFlow® VI Design Express.

XXeerrooxx®® FFrreeeeFFllooww®® VVIIPPPP MMaannaaggee 

• Added functionality to support submitting VIPP® jobs to Xerox® Office Printers, such as AltaLink® C8130, B8170, 
C8070, B8090. When referencing the printer within VIPP Manage, ensure to use V3 Xerox Global Print Driver 
PostScript. Otherwise, these jobs will not be processed properly. You can download the V3 Xerox® Global Print 
Driver PostScript from www.xerox.com.

VVeerrssiioonn 1177..00..33

XXeerrooxx®® FFrreeeeFFllooww®® VVII DDeessiiggnn PPrroo 

• Fixed issue when uninstalling 17.0.x, the uninstallation resulted in the removal of the xgfc directory and other 
installed VI Suite applications. It is strongly recommended Xerox® FreeFlow® VI Design Pro is updated to version 
17.0.3 from 17.0.x to avoid this issue. If upgrading from 17.0.x to 18.0.1, updating to 17.0.3 is not required.

XXeerrooxx®® FFrreeeeFFllooww®® VVII EExxpplloorreerr 

• Fixed the issue when uninstalling 17.0.x, the uninstallation resulted in the removal of the xgfc directory and 
other installed VI Suite applications. It is strongly recommended Xerox® FreeFlow® VI Explorer is updated to 
version 17.0.3 from 17.0.x to avoid this issue. If upgrading from 17.0.x to 18.0.1, updating to 17.0.3 is not 
required.
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Xerox® FreeFlow® VI Design Express

If you are upgrading from a version earlier than 16.0.2.0, before you install Xerox® FreeFlow® VI Design Express 
version 16.0.3.x/17.0.0.0/17.x.x/18.x.x, ensure that you uninstall the current version of Xerox® FreeFlow® VI Design 
Express.

INSTALLING XEROX ®  FREEFLOW ®  VI  DESIGN EXPRESS ON MAC

To install Xerox® FreeFlow® VI Design Express on a Mac, perform the following:

1. To mount the VI Design Express installation disk on the desktop, double-click the VDE_Install_18.x.x. 
dmg file.

2. To install the VI Design Express, double-click the installer application. 
A dialog box appears with the message VDEInstaller.app is an app downloaded from the 
internet. Are you sure you want to open it? Select the option Don’t warn me when opening 
applications on this disk image, then click Open. 

Important: For macOS Catalina installations, if you do not select the option Don’t warn me when 
opening applications on this disk image, and you run the installer directly from the .dmg file path, 
the installation can fail without notification. For macOS Big Sur installations, if you do not select the 
option Don’t warn me when opening applications on this disk image, and you run the installer 
directly from the .dmg file path, a java cannot be opened because the developer cannot 
be verified, select cancel to terminate message appears.

3. An authorization dialog box appears on the screen. If the logged-in user has administrative privileges, type the 
appropriate password. If the logged-in user does not have administrative privileges, a nonPrivAuth dialog 
appears. Ensure that the appropriate user’s name and password are entered, then select Install Helper.

4. A dialog box appears with the message iCloud Drive may not work properly. To proceed, select OK.

5. When the language dialog box appears, select the appropriate language for the installer to use from the menu. 
Follow the onscreen instructions to read and confirm the End User License Agreement (EULA) and complete the 
installation.

UPGRADE FREEFLOW ®  VI  COMPOSE ON THE PRINTER

If you are using Xerox® FreeFlow® VI Design Express version 18.0.6, ensure that you upgrade Xerox® FreeFlow® VI 
Compose to version 18.0.6 on the printer. 

Note: Before you choose automatic Adobe InDesign or Creative Cloud updates, verify that your version of VI 
Design Express runs on the later version of the Adobe software. Ensure that you disable this automatic 
update process.

UNINSTALLING XEROX ®  FREEFLOW ®  VI  DESIGN EXPRESS ON MAC

To uninstall Xerox® FreeFlow® VI Design Express on a Mac, perform the following:

1. Open Launchpad.

2. Select Change Xerox FreeFlow VI Design Express Installation.
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3. Enter Administrator credentials, then select Uninstall. 

If the Xerox® FreeFlow® VI Design Express is installed for both Adobe InDesign 2023 and 2024, uninstalling 
removes the Xerox® FreeFlow® VI Design Express plug-in from both Adobe InDesign versions.

SPECIFYING MEDIA AND FINISHING OPTIONS FOR A JOB SENT TO A PRINTER

When a VIPP job is created from the Export option, a VI Project Container is created. If a container that specifies 
media and finishing options is sent to the printer, sometimes, the options cannot be honored, depending on the 
printer controller used. Xerox printers that run FreeFlow Print Server version 9 or later for Solaris and version 2 or 
later for Windows support media and finishing options.

If FreeFlow Print Server (FFPS) processes the job, the print server, along with the printer, determines which media 
and finishing options are applied to the job.

INSTALLING XEROX ®  FREEFLOW ®  VI  DESIGN EXPRESS ON WINDOWS AND MAC

The installation of Xerox® Freeflow® VI Design Express will always be installed in the default location of Adobe 
InDesign, normally C:\Program Files\Adobe (Windows) and /Applications/ (Mac). If Adobe InDesign 
is installed in a directory other than the default location, installation of FreeFlow VI Design Express will fail stating 
the installation of the Adobe InDesign application is missing. Ensure that Adobe InDesign is installed in the default 
location while installing FreeFlow VI Design Express.

UPGRADING XEROX ®  FREEFLOW ®  VI  DESIGN EXPRESS ON MAC TO 18.0 .3  OR LATER

After upgrading to Xerox® FreeFlow® VI Design Express 18.0.3 or later on a MAC, it is required to reboot the system. 
Failure to do this step will result in the uninstallation of Xerox® FreeFlow® VI Design Express 18.0.3 or later to not 
succeed if it is uninstalled later.

JOB SUBMISSION TO XEROX ®  FREEFLOW ®  CORE WORKFLOW NAMES CONTAINING COMMA 

CHARACTERS

When you submit the jobs to Xerox® FreeFlow® Core, if the name of the FreeFlow Core workflow contains a comma 
character, the workflow name shown in Xerox® FreeFlow® VI Design Express will be truncated and if submitted to 
the workflow, it will fail with an error message as The workflow is not found. Remove the comma character 
to rename the workflow at Xerox® FreeFlow® Core.

XEROX ®  FREEFLOW ®  VI  DESIGN EXPRESS JOB SUBMISSION TO XEROX ®  FREEFLOW ®  CORE 

Both the Xerox® FreeFlow® Core installed machine and Xerox® FreeFlow® VI Design Express installed machines 
should be in the same network. 

XEROX ®  FREEFLOW ®  VI  DESIGN EXPRESS JOB STATUS PANEL

The following describes limitations when using the FreeFlow Core Job Status dialog.

The Refresh button works only in the All-Jobs tab. In other tabs, Refresh does not work. Selecting another tab and 
switching back to the previously selected tab updates the job status. Selecting the Refresh button updates the job 
status.
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After invoking the Delete button for selected jobs shown in the job status view, jobs will be removed from the 
display immediately only if the jobs are deleted from the All-Jobs view. If a job is deleted from the other views, the 
deleted job remains visible. After switching to another tab view and back to the original tab view, the display gets 
updated correctly.
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Xerox® FreeFlow® VI Design Pro

PERFORMANCE ISSUE WHEN USING PROCSETS

VIPP® jobs with several hundred or more {…} pairs (ProcSets) experience a performance issue. On most VIPP® jobs 
loaded into Xerox® FreeFlow® VI Design Pro, the additional overhead will not have a perceptible impact. However, if 
the number of {…} pairs (ProcSets) in the job exceeds the threshold of several hundred or more, then the new 
instrumentation process can have a significant performance impact. Most VIPP® jobs do not use this many 
ProcSets, but there have been cases reported where the number of ProcSets can exceed several thousand.

Since the change to the ProcSet instrumentation behavior was necessary to address a VI Design Pro or VI Design 
Express compatibility issue, and as most customers are not using thousands of {…} pairs in their VIPP® jobs, the 
more fine-grained analysis is still performed by default.

However, for VI Design Pro 17.0.0.0, there is support for an additional, optional .INI entry: Disable_curly_brace_ 
instrumentation = 1.

When this option is present and set to 1, the fine-grained analysis of ProcSets will not be performed. But the other 
instrumentation will be unaffected. When this option is enabled for customers that use many {…} pairs in their jobs, 
the VI Design Pro performance returns to pre-16.0.2.0 speed.

In the updated Xerox® FreeFlow® VI Design Pro user interface, the job submission file order numbers on the 
submission file icons in Project view were omitted. The submission files are still presented in the correct order in the 
Project view. The submission file order numbers will be added in a future update.
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Xerox® FreeFlow® VI eCompose

ENABLING OPTIONAL FEATURES AFTER THE INITIAL INSTALLATION

To enable the optional FreeFlow VI eCompose features, run the installer, and select the features that you want to 
enable, such as Web Application or LPR Job Submission.

INITIALIZING XEROX ®  FREEFLOW ®  VI  ECOMPOSE FOR THE FIRST TIME

After the system restart of Xerox® FreeFlow® VI eCompose, if you connect to the Web Application for the first time, 
there is a delay before the login dialog appears.

UPGRADING FROM A PREVIOUS VERSION

When you upgrade from a previous version, the new default installation directory is C:\Program Files (x86) 
\Xerox\VIPP\xvtp and the default xgfc location is C:\Program Files (x86)\Xerox\VIPP\xgfc. It is 
possible to modify these default directories. After you upgrade from systems prior to 16.0.0.0, you can use the 
sha2passwd utility to reset the password of a user. After you upgrade to 16.0.3.1/17.x.x, you can use the utility only 
once for a registered user.

PASSWORD CHANGE UTILITY AFTER AN UPGRADE TO 17.X .X

To reset a password in FreeFlow VI eCompose version 16.0.3.x or 17.x.x, perform the following steps:

1. Open the command prompt.

2. Change the directory to X:\Program Files (x86)\Xerox\VIPP\xvtp\bin, where X is the disk 
partition where the Xerox® FreeFlow® VI eCompose software is installed.

3. Enter the command using the following syntax: ChangePassword.exe <username> <password> 
<port>, then press Enter. 
The following definitions apply: 

• username: The user’s name for which the password needs to be changed.

• password: The new password for the user.

• port: If the default port has changed, specify the port number. 

If the port has not changed, do not include the port argument in the command.

Example:

ChangePassword.exe test test@123

ChangePassword.exe test test@123 9000

JAVA ERROR DIALOG OBSERVED DURING INSTALLATION

During installation of Xerox® FreeFlow® VI eCompose on Windows operating systems, a dialog displaying a Java 
Error may appear. Click OK to proceed with the installation. The installation will proceed successfully, and the 
application will work fine after the system restart.
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Xerox® FreeFlow® VI Compose

If you are using an EFI Fiery print server, before you proceed with VIPP® printing, ensure that all updates or patches 
for your EFI Fiery print server product are applied.

If updates or patches for your EFI Fiery print server product are not applied, Xerox® FreeFlow® VI Specialty Imaging 
fonts and Specialty Imaging jobs do not load or are not recognized.

Patches are available through your EFI Fiery device center available through your EFI Fiery Command Workstation 
(CWS).

Note: If you encounter a license upgrade or activation error, then turn off your Antivirus Guidance and retry 
the activation.

After activating the FreeFlow VI Compose license, any unprocessed jobs residing at the EFI Fiery print server are 
required to be resubmitted to be properly processed. To set up a EFI DFE for VIPP printing, refer to FreeFlow® VI 
Suite Specialty or Security Imaging for VI Compose and Design Express on a Fiery DFE - FreeFlow Variable 
Information Suite - Xerox.
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Xerox® FreeFlow® Variable Information Suite Application Installed on Windows

SELECTING XGFC DIRECTORY LOCATION DURING INSTALLATION

On Windows Operating systems where Variable Information Suite applications are installed, for example, FreeFlow 
VI Design Pro, FreeFlow VI Explorer, FreeFlow VI eCompose, FreeFlow VI Design Express, there can be occurrences 
when opening a VPC file, where the contents are found in the directory, C:\Users\<username>\AppData 
\Local\VirtualStore\Program Files (x86)\Xerox\VIPP\xgfc instead of the default xgfc location 
C:\Program Files (x86)\Xerox\VIPP\xgfc when the application is installed. If this occurs, the logged in 
user will not have permissions to the C:\Program Files (x86) directory. If the user does not have permissions 
to this directory, uninstall the FreeFlow VI application and reinstall changing the xgfc directory to another directory, 
where the user has file permission access. 

HOST ID INSTALLER SCREEN PANEL

While installing the following applications, Xerox® FreeFlow® VI eCompose, Xerox® FreeFlow® VI Compose, and 
Xerox® FreeFlow® VI Compose Open Edition 18.1.1 installer in a system, the username ends with an exclamation 
mark "!" . During Pre-install phase, in Host ID Installer screen panel, the system Host ID details or the information 
are not populated in the installer screen and installation can be proceeded, but it will complete with a Non-fatal 
install error.
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Creating a VPC File Compatible with Xerox® FreeFlow® Core for Splitting Based on 

Records

A VPC file created from Xerox® FreeFlow® VI Design Express can be used by Xerox® FreeFlow® Core where if a 
workflow contains a split node, the split node will be able to split the contents based on Variable Data Records.

The FreeFlow Core workflow must be configured where the Job Options File setting is PDFX3 2003.joboptions or 
PDFX3 2003 JPN.joboptions. This will convert the VPC file from VI Design Express to a PDF/VT file that can be 
processed by the split node.

To enable the file creation from FreeFlow VI Design Express, use the Advanced Functions and perform the following: 

• Add a new Advanced function using the section Adding a New Advanced Function.

• Enter the VIPP® code STARTOFSET in the VIPP® Command Statements text area.

• Select Execute this command option to At start of document.

• Select OK to close the Advanced Function dialog.

• Submit the job to FreeFlow® Core. For more information, refer to the VIPP® Job Submission to FreeFlow Core 
and getting status back from FreeFlow Core section in Xerox® FreeFlow® VI Design Express Software User Guide.

A VPC file or PDF file with PDF/VT option created from Xerox® FreeFlow® VI Design Pro can be used by Xerox® 

FreeFlow® Core where if a workflow contains a split node, the split node will be able to split the contents based on 
Variable Data Records.

To enable the VPC file creation from Xerox® FreeFlow® VI Design Pro with splitting based on records, perform the 
following steps:

1. Open VPC file in Xerox® FreeFlow® VI Design Pro.

2. Find the dbm file in the project files.

3. Add STARTOFSET command at the start of the DBM file.

4. Save the file.

5. Go to File > Menu and select Export project container. 
It will create the VPC file again with the modified contents.

6. Send the new VPC file to Xerox® FreeFlow® Core.

To create a PDF file with PDF/VT option from VI Design Pro with splitting based on records, perform the following 
steps: 

1. Open VPC file in Xerox® FreeFlow® VI Design Pro.

2. Find the dbm file in the project files.

3. Add STARTOFSET command at the start of the DBM file.

4. Save the file.

5. Go to File > Menu and select Export job as PDF.

6. Enable the check box Include media and finishing option.

7. Enable the check box Create PDF/VT-1 compliant PDF.

8. Select the job options file name PDFX3 2003.joboptions or PDFX3 2003 JPN.joboptions.

42 Xerox® FreeFlow® Variable Information Suite What's New in Version 18.1.1 Reference Guide

Hints and Tips



9. Click the OK button.

10. Send the generated PDF file to Xerox® FreeFlow® Core.
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Adobe PDF Print Engine (APPE)

Media and finishing control are available with PDF output when generated by FreeFlow VI eCompose, which 
requires option to be selected and printing to the FFPS OR when printing VIPP® directly to the FFPS using the APPE 
path.

To print to the FFPS, ensure that you set the FFPS queue to APPE and the format to PDF.

Ensure that you have the latest FFPS software installed on the target print device, version 93.D4.x.x or later.
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PDF Using VI Suite Tool Set

You can convert a VIPP® job to PDF using one of three methods. 

1. VI eCompose is the FreeFlow VI Suite production-level VIPP®-to-PDF solution. The VI eCompose software runs 
on a Windows server. Four input clients are provided, including LPR, Watched Folder, Job Submission Client, and 
the Web submission client. The VI eCompose software, based on the content of the VIPP® application, 
generates a Master PDF. It can generate child PDF files also and move those PDF files to the next step in your 
workflow using the VI eCompose Dispatch module. For more information on FreeFlow VI eCompose, refer to the 
FreeFlow VI eCompose User Guide or go to www.xerox.com.

2. VI Design Pro, the interactive design environment for the generation of code-based VIPP® applications, has an 
Export job as PDF option from the file menu. You can use this option to generate a Master PDF file. For more 
information on FreeFlow VI Design Pro, refer to the FreeFlow VI Design Pro User Guide or www.xerox.com.

3. VI Design Express is the Adobe InDesign plug-in that runs on a Windows PC or a Mac OS system. This plug-in 
allows for rapid development of delimited-based VIPP® applications. FreeFlow VI Design Express supports an 
option to generate PDF output using the VI Design Express PDF option from the InDesign Export menu.

ADOBE ACROBAT AND ADOBE READER INFORMATION

If you are using PDF Objects as VIPP® resources in your VIPP® application and you need to view the PDF file output 
from VI eCompose using Adobe Acrobat or Adobe Reader, ensure that you are using Adobe Acrobat or Adobe 
Reader, version 10.1.4 or later.

CONFIGURING ADOBE ACROBAT AND ADOBE READER PRIVILEGED FOLDER SETTINGS

To view PDF files that contain VIPP® PDF resources, ensure that you open the PDF file from an Adobe Acrobat or 
Adobe Reader privileged folder. 

To create a privileged folder, edit the following Adobe Acrobat or Adobe Reader preferences:

1. From the Adobe application, select Edit > Preferences. 

2. Under Categories, select Page Display.

3. At the bottom of the window, under Reference XObjects View Mode, for Show reference XObject targets, select 
Always.
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4. For Location of referenced files, specify the path to the directory that contains the PDF files generated by VIeC. 

Note:  

• It is recommended that you select the VIeC incoming folder instead of the folder containing a specific 
job.

• If all the PDFs generated by VIeC are under the same incoming folder hierarchy, all referenced PDFs will 
be located and properly displayed.

5. Under Categories, select Security (Enhanced).
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6. Under Privileged Locations, click Add Folder Path, then specify the same folder as specified for Location of 
referenced files. 

Note:  

• The referenced XObjects are independent of the Enhanced Security checkbox. The state of the checkbox 
does not govern viewing of referenced XObjects.

• Any of the following can cause Adobe Acrobat or Adobe Reader to display Missing: followed by the 
name of the missing PDF resource: 

– The version of Acrobat or Reader does not support Referenced XObjects 

– The preferences were not setup correctly 

– The PDF file was opened from a non-privileged folder 

Xerox® FreeFlow® Variable Information Suite What's New in Version 18.1.1 Reference Guide 49

Important Information About PDF



50 Xerox® FreeFlow® Variable Information Suite What's New in Version 18.1.1 Reference Guide

Important Information About PDF



Xerox® FreeFlow® Variable Information Suite What's New in Version 18.1.1 Reference Guide 51

FreeFlow VI Suite Printer Support

This chapter contains:

Printer Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

The FreeFlow VI Suite 18.0.0 release products support both the new Vacuum Assisted Tray (VCA) and Extra Large 
Stacker (XLS). The XLS or oversized tray allows print jobs with a maximum size of 330 x 1200 mm (13 x 47.25 in.).



Printer Support

The FreeFlow Variable Information Suite 18.0.0 release supports the following printers: 

XEROX® PRINTER 
CONTROLLER AND MINIMUM SUPPORTED 
VERSION OF XEROX® DEVICES 

Xerox® AltaLink® B80xx/B81xx Standard Controller

Xerox® AltaLink® C80xx/C81xx Standard Controller

Xerox® EX-c C8000 Print Server, Powered by Fiery®

Xerox® PrimeLink® B9100 Series Printer Xerox® Integrated Server

Xerox® EX B9100 Series Print Server Powered by Fiery®

Xerox Nuvera® 1xx/200/288/314 Xerox® FreeFlow® Print Server 7.0 SP3 (CP.73.C3.x) and 
higher

Xerox® PrimeLink® C9065/C9070 Printer Xerox® Integrated Color Server

Xerox® EX 9065-70 Print Server, Powered by Fiery®

Xerox® EX-i 9065-70 Print Server, Powered by Fiery®

Xerox® EX-c 9065-70 Print Server, Powered by Fiery®

Xerox® Color C60/C70 Printer Xerox® EX/EX-i C60/C70 Print Server 1.0, Powered by 
Fiery®

Xerox® Integrated Color Server

Xerox® FreeFlow® Print Server Integrated 2.0 SP1

Xerox® Color C75 Press Xerox® EX Print Server 1.0, Powered by Fiery®

Xerox® Integrated Fiery Color Server 1.0

Xerox® FreeFlow® Print Server 9.0 SP3

Xerox® Versant® 4100 Press Xerox® EX-P 4100 Print Server 1.0 and higher

Xerox® EX 4100 Print Server 1.0

Xerox® Versant® 3100 Press Xerox® EX/EX-P 3100 Print Server 1.0 and higher

Xerox® FreeFlow® Print Server 9.0 SP3

Xerox® Versant® 2100 Press Xerox® EX/EX-P 2100 Print Server 1.0 and higher

Xerox® FreeFlow® Print Server 9.0 SP3

Xerox® Versant® 280 Press Xerox® EX 280 Print Server 1.3 and higher

Xerox® EX-i 280 Print Server 1.3 and higher

Xerox® Versant® 180 Press Xerox® EX/EX-i 180 Print Server 1.0 and higher
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XEROX® PRINTER 
CONTROLLER AND MINIMUM SUPPORTED 
VERSION OF XEROX® DEVICES 

Xerox® FreeFlow® Print Server 9.0 SP3

Xerox® Versant® 80 Press Xerox® EX/EX-i 80 Print Server 1.0 and higher

Xerox® FreeFlow® Print Server 9.0 SP3

Xerox® Iridesse® Production Press Xerox® EX-P 6 Print Server 1.0 and higher

Xerox® iGen® 5 150 Press Xerox® EX-P 5 Print Server, Powered by Fiery®

Xerox® FreeFlow® Print Server 21 (CP.21.0.15141.0) and 
higher

Xerox® iGen® 5 90/120 Press Xerox® EX Print Server 1.1, Powered by Fiery®

Xerox® FreeFlow® Print Server 21 (CP.21.0.15219.0) and 
higher

Xerox® iGen® 150 Press Xerox® EX Print Server 1.0, Powered by Fiery®

Xerox® FreeFlow® Print Server 9.0 SP1

Xerox® Color 8250 Production Printer Xerox® FreeFlow® Print Server 9.0 SP3

Xerox® iGen4® (90/100/220 Perfecting) and Diamond 
Edition

Xerox® EX Print Server 1.0, Powered by Fiery®

Xerox® FreeFlow® Print Server 9.0 SP1

Xerox® Baltoro® HF Inkjet Press Xerox® FreeFlow® Print Server 24 (CP.24.0.19119.0) and 
higher

Xerox® Brenva® HD Production Inkjet Press Xerox® FreeFlow® Print Server 22

Xerox® VersaLink® B625 and Xerox® VersaLink® B620 Standard Controller

Xerox® VersaLink® C625 and Xerox® VersaLink® C620 Standard Controller

Note: VIPP® printing is supported on the specific Xerox® AltaLink® series printers listed above.

Note: The FreeFlow VI Suite specialty printing is not supported on all the Office printers. For more 
information on Office application VI printing, contact your Xerox representative.

Additional information about the VIPP® Specialty Imaging support for these printers can be found at www.xerox. 
com. Select Customer Support > All Support and Drivers. For product type, select Software & Platforms, then 
select FreeFlow > FreeFlow Variable Information Suite. Go to the documentation area, then search for an 
updated FreeFlow VI Suite Specialty Imaging Customer Report.
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License Disclosures

License disclosures for third-party components utilized in Xerox® FreeFlow® Variable Information Suite applications 
can be found at the following locations for installs performed using the default location. For installs performed with 
a different drive location, the license disclosures can be found in the ThirdPartyLicenses folder under the installation 
location. 

XEROX FREEFLOW VI APPLICATIONS DIRECTORY LOCATION 

Xerox® FreeFlow® VI Design Express C:\Program Files (x86)\Xerox\VIPP\xvtp 
\bin\ThirdPartyLicenses 

Xerox® FreeFlow® VI Design Pro C:\Program Files (x86)\Xerox\VIPP\vide 
\ThirdPartyLicenses 

Xerox® FreeFlow® VI eCompose C:\Program Files (x86)\Xerox\VIPP\xvtp 
\bin\ThirdPartyLicenses 

Xerox® FreeFlow® VI Explorer C:\Program Files (x86)\Xerox\VIPP\vviewer 
\ThirdPartyLicenses 

Xerox® VIPP® Manage Utility C:\Program Files (x86)\Xerox\VIPP 
\VIPPManage\ThirdPartyLicenses 
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